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Preface

This book is a resource for web designers who want to use Photoshop to create

better-looking web graphics.

Unlike the many other web-related Photoshop books on the market, this book

does not encourage you to use Photoshop’s generated HTML code, which, as of
this writing, does not use semantic markup or conform to W3C guidelines. I view
Photoshop as only one of many tools in the web development process; knowledge
of how to actually code a web site using HTML, CSS, and other web languages is
equally important but is not covered in this book, which is strictly about using
Photoshop to create graphics for web sites. I encourage you to look into the many
other resources, both in online and book form, that will teach you the basics of web

development if you need to pick up skills in those areas.

Unlike other Photoshop books geared towards web designers, this book comes with
downloadable files that you can also create yourself, following my instructions!
Many of the glossy, colorful books already on the market have stunning web
graphics, but provide them in nearly-complete source files that are designed to help
you learn a basic principle in Photoshop, but do not actually show you how to create
those graphic effects yourself. This book was written to give you some of the building
blocks and techniques that will help you to create your own cool web graphics.
There’s no need to dedicate several hours each week to work through an extensive
“project”—the anthology format of this title allows you to quickly look up a task

or effect you're curious about, and accomplish it immediately, following clearly

outlined instructions.

There are hundreds of online tutorials about creating various web graphic effects
in Photoshop. This book shows you how to create many of those same effects,

but most solutions include a “Discussion” section that goes beyond the “step-by-
step” stage to explain some of the concepts behind the solution, enabling you to
understand more of how Photoshop works so that you can apply that knowledge
in other situations. One of the most valuable solutions in this book, and which

can be found at the beginning of Chapter 8, gives you a conceptual “road map” of
how to use Photoshop in the web design process and illustrates it with an example
that combines many of the techniques explained in earlier chapters (see Chapter 8,

Designing a Web Site).

Order the print version of this book to get all 286 pages!
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Because this book is focused towards web designers, I cover only some of the
basic and intermediate tasks related to photo adjustments and retouching. If this
area interests you, there are many excellent books, geared towards professional
photographers and artists, which provide more advanced instruction than does
this title.

My primary hope is that this book will help you to build up the skills and knowledge

you need to become comfortable and confident while using Photoshop to create web

graphics. Good luck, and have fun!
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Who Should Read this Book?

This book is ideal for all web designers working with Photoshop: if you’re new to the
application, there’s enough beginner material here to give you a great grounding in
the basics, but if you’ve got a bit more experience up your sleeve, there’s coverage of

a multitude of advanced tutorials for you to get your designs looking beautiful.

What Version of Photoshop do | Need?

Most of the techniques in the book will work regardless of the version of Adobe
Photoshop that you’re using. However, the book is intended for web designers using
Photoshop CS2, and there are some solutions that make use of the newer features

in this version. Some of the shortcuts differ between versions of Photoshop, so keep

this in mind if you’re working with an older version.

What's in this Book?

Chapter 1: Getting Started with Photoshop
If you’re brand new to Photoshop, come here to learn about how to get around. If

you’re not brand new, you may still enjoy the time-saving tips included in these pages.

Chapter 2: Basic Skills
Build a good foundation for your use of Photoshop with these basic skills, including

resizing, rotating, and hiding parts of your picture.

Chapter 3: Creating Buttons
Make buttons of every shape and style by following the solutions in this chapter.

Chapter 4: Creating Backgrounds
Create tiling backgrounds that you can use in design elements such as headings and

menu bars, or even the page background itself!

Chapter 5: Working with Text

Learn to adjust type settings and make cool text effects for your next logo or web graphic.

Chapter 6: Adjusting Images
Fix, salvage, and adjust photographs that are over-exposed, under-exposed, or just

dull-looking. Or, take a good photograph and make it look even better!
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Chapter 7: Manipulating Images
Start with a photograph or image and add your own effects such as scanlines,

reflections, and more!

Chapter 8: Designing a Web Site
Bringing all the skills from previous chapters together, this chapter shows you how

to create web design mockups in Photoshop, then generate web-optimized images.

Chapter 9: Advanced Photoshop Techniques
Automate and animate! This chapter shows you how to save time when performing
similar tasks on many different files, then shows you how to use Photoshop and

ImageReady to create animations.

The Book's Web Site

Located at http://www.sitepoint.com/books/photoshop1/, the web site supporting

this book will give you access to the following facilities.

The File Archive

The file archive is a downloadable ZIP archive that contains all of the examples
presented in the book as PSD files. It contains a file for every example covered,
including original photos used and final versions. You can get it from

http://www.sitepoint.com/books/photoshop1/archive.php.

Updates and Errata
The Corrections and Typos page on the book’s web site will always have the latest
information about known typographical and code errors, and necessary updates.

Visit it at http://www.sitepoint.com/books/photoshop1/errata.php.

The SitePoint Forums

While we’ve made every attempt to anticipate any questions you may have, and

answer them in this book, there’s no way that any book could teach you everything
you’ll ever need to know about using Photoshop. So, if you have a question about
anything in this book, or about the implementation of the techniques you’ve learned
here in other projects, the best place to go for a quick, helpful and friendly answer

is http://www.sitepoint.com/forums/—SitePoint’s vibrant and knowledgeable

community.
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The SitePoint Newsletters

In addition to books like this one, SitePoint offers free email newsletters.

The SitePoint Tech Times covers the latest news, product releases, trends, tips, and
techniques for all technical aspects of web development. The long-running SitePoint
Tribune is a biweekly digest of the business and moneymaking aspects of the Web.
Whether you're a freelance developer looking for tips to score that dream contract,
or a marketer striving to keep abreast of changes to the major search engines, this is
the newsletter for you. The SitePoint Design View is a monthly compilation of the
best in web design. Covering everything from new CSS layout methods to subtle
Photoshop techniques, the newsletter delivers a wealth of practical information

compiled by SitePoint’s chief designer.

Browse the archives or sign up to any of SitePoint’s free newsletters at http://www.

sitepoint.com/newsletter/.

Your Feedback

If you can’t find an answer through the forums, or you wish to contact us for any
other reason, the best place to write is books@sitepoint.com. We have a friendly and
helpful email support team available to help you with your inquiries, and if our staff
are unable to answer your question, they send it straight to the author. Suggestions

for improvement, as well as notices of any mistakes you may find, are especially

welcome.
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Getting Started

with Photoshop

You’ve heard of Photoshop, right? Of course you have—you
wouldn’t be reading this book otherwise! You’ve probably
heard of Photoshop’s sidekick, ImageReady, too, but you

might not be quite sure of what it does or where it fits in.

Photoshop and ImageReady are two of the most commonly
used tools in the web designer’s arsenal. From the
preparation of initial design comps to generating optimized
graphics for a web page, most web designers rely heavily on

these two programs.

In this introductory chapter, I'll cover some of the basic

tools and tasks that we’ll draw on in the later chapters. I'll
also share some of the shortcuts and time-savers that I use
frequently. This chapter won’t give you an exhaustive review
of the many things that Photoshop can do (where would it
end!), but it should provide the bare bones that will help get
beginners started. If you’re already familiar with the interface
and can perform tasks like making selections, applying
gradients, and working with layers, you might want to skip

ahead to the next chapter.

So what are you waiting for? Open up Photoshop and let’s go!
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The Photoshop Workspace

Photoshop’s “out of the box” workspace consists of

the following components:

B menu bar

TIP Comps and Turtlenecks:
Designer Lingo

You will probably already be familiar with the
menu bar from other programs. This runs across
the top of your Photoshop window, and contains

various menu options for Photoshop’s tools.

options bar

The options bar sits beneath the menu bar and
holds contextualized options for different tools.
It also contains the palette well, where you can

“dock” palettes.

toolbox
By default, the toolbox sits to the left of your

Photoshop window, and contains shortcuts

to Photoshop tools.

palettes

Individual “panes” that hold information or options for working with your file,
known as palettes, float on the right-hand side. Each palette is labeled with a
tab, and can be minimized, closed, grouped with other palettes, or dragged to
the palette well. In the example at the top of the next page, the Navigator palette
contains a thumbnail of the image that allows you to zoom in or out of the image

quickly, and to change the part of the image displayed on the screen.

document windows
Each open document has its own document window with a status bar along the
bottom. The status bar sits to the right of the zoom percentage displayed in the

bottom left-hand corner, and displays information that’s specific to the document.
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The Photoshop workspace

Customizing your Workspace
You can customize your Photoshop workspace to suit you or your project—almost
everything within your workspace can be repositioned and reconfigured! You might

choose to customize your workspace by:

B changing the look of the menu bar
You can change which menu items are visible in your menu bar, and even add
color to your menu items. If you wanted, you could also assign new or different
keyboard shortcuts to menu commands (which I don’t recommend until you feel
very comfortable with Photoshop or have a compelling reason to do so!). Go to

Edit > Menus and use the dialog box to modify the menu bar and palette menus.

B moving the options bar
If you want to move the options bar, you can do so by clicking on the handle
on its left side and moving it around. The options bar will “dock” to the top or

bottom of the screen automatically if moved near those areas.
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B moving the toolbox

The toolbox is extremely portable, and can be moved to any location on your

screen. Move the toolbox by clicking on the gray area at the top of it and dragging

it around.

B rearranging palettes

There are many ways to rearrange your palettes. You might want to separate a

palette from its palette group, and move it into another group. You can do this

by dragging the palette tab out of its original group and into the new group. You

might also decide to drag some of your palette tabs into the palette well, and

close the rest. To display a palette that has been closed, go to Window and select

the palette you want to show.

B displaying different information in the

document window status bar

@UOJ-Iﬂyerssplitaparl?.psd @ 66.7% (The sacred lamp of day Mow d.R... L.__]LE.IJE

The status bar displays the document Sunset Sky

file size by default. The file size is
shown as two numbers separated by

a forward slash: the first number is

an approximation of the image file

size with all layers merged (known as
“flattening” the image), and the second
number is an approximation of the
total file size of the image with layers

intact. If all this sounds new to you, ma. o

Wersions...

don’t worry—we’ll be discussing layers Alemates...
Reveal in Bridge. ..

shortly. You can set the status bar to

Shaw >

display different information, such as

the document dimension in pixels, or

the version number of the file. To do

this, click on the arrow icon next to the

status bar, select Show and choose the Changing the status bar

information you’d like to see.

Saving your Customized Workspace
As you become more proficient with Photoshop, you may discover that you use
certain sets of palettes for different types of projects, and that there are some

palettes that you don’t use at all. Photoshop allows you to save and load different

Version Cug

v Diocurnert Sizes
Document: Profile
Document Dimensi
Scratch Sizes
Efficiency
Timing
Current Taal
32-bit Exposure

s
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workspaces—different arrangements of palettes, menus, and even different keyboard

shortcuts—to help you work more efficiently.

After you’ve customized your workspace to your satisfaction, select Window >
Workspace > Save Workspace from the menu bar and enter a name for your workspace,
such as Creating Thumbnails or My Default Workspace. You can then load your different
workspaces by opening Window > Workspace and selecting your custom workspace

from the menu list.

Working in Photoshop

Now that you’ve been introduced to the Photoshop workspace and have a basic idea

of where everything is, let’s start getting our hands dirty.

Creating o
New Documents Marne: | Unitied-1]
Preset; | Custom |"§ i |
You can create a new document o (et ul e
by selecting File > New from the Height: | 300 s |v]
menu bar, or pressing the Fettiyg) 72 ppelsfocn ||
keyboard shortcut Ctrl-N on a PC o IR HT lvj et
Background Contents: | white |V§
or Command-N on a Mac. ==
#) Advanced
The New dialog box will appear, ,
Color Profile; !jl}GB [EC61966-2,1 |Vi
where you can specify the Bl et Ratiod] Souars v

document size and other settings.

The New dialog box

Opening Files

Open files by selecting File > Open from the

TIP Snappy Presets

If you're designing for a web site with a minimum screen
size of 800x600 pixels, I'd recommend you start with a
750x550 pixel document. The smaller dimensions give you a
files by holding down Ctrl (Command on better estimate of your actual screen area after you take into
a Mac) and clicking on all the files you account scroll bars and menu bars. Also, be sure to set the
resolution at 72dpi to reflect the actual screen resolution.

menu bar, or pressing Ctrl-O (Command-O on

a Mac). You can select and open multiple

require in the file dialog box.

If you want easy access to these dimensions for other new
SaVing FiICS documents, it's probably a good idea to click Save Preset
and give the settings a name like Web Page. The next time
you create a new document, you will be able to load your
Web Page settings from the Preset list.

Save a file by selecting File > Save, or
pressing Ctrl-S (Command-S on a Mac). For

a newly-created document, this will save

your work in Photoshop Document (PSD)

Order the print version of this book to get all 286 pages!
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format. If you would prefer to save a copy of the document, you can use File > Save As

or pressing Ctrl-Shift-S (Command-Shift-S on a Mac) instead.

Saving Files for the Web

Photoshop files themselves can’t be embedded into a web page. You will need to

export your file and save it in a web-friendly format. There are three formats for web
graphics: GIFs, JPEGs, and PNGs.

B GIF

The GIF format (pronounced “jiff” or “giff” depending on which side of the
tracks you grew up) can have a maximum of 256 colors. GIF files support
transparency and animation, and work best with graphics that have large areas of

the same color, as shown in the logo below.

JPEG

The JPEG format (pronounced “jay-peg”), works best with photographic images
or images that have more than 256 colors and gradients, such as the flower on the
opposite page. Images saved in JPEG format are compressed, which means that

image information will actually be lost, causing the image to degrade in quality.

PNG
The PNG format (pronounced “ping”)

is similar to the GIF format in that it . YD'U r CDIT'IPEI ny

supports transparency and works best
. . . . Example of an image that should be saved as GIF or PNG
with solid-color images like the logo xamp mag ! .

shown to the right, but it’s superior to the GIF format as it has the ability to

TIP Double-clicking Power
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support true levels of transparency for colored areas. Transparent PNGs

are currently not in widespread use on the Web because older versions of
Microsoft Internet Explorer do not support them; however, they’re often used in
Macromedia Flash movies. PNGs can produce a better quality image at a smaller
file size than can GIFs. Photoshop allows you to save an image as a PNG-8 file
(which works the same way as a GIF would with 256 colors) or a PNG-24 file

(which allows for millions of colors as well as variable transparency).

To save for the Web in Photoshop, select

File > Save for Web... or press Ctrl-Alt-Shift-S
(Command-Option-Shift-S on a Mac). This will
bring up the Save For Web dialog box shown
overleaf, which will show you a preview of the
image that will be exported, with its optimized
size in the bottom left-hand corner. You can

adjust the settings for the image using the

options in the pane on the right. Choose
whether you want to save the file as a GIF,
JPEG, PNG-8, or PNG-24, and have a play

with the other settings, keeping an eye on the optimized file size. Try to strike a

Example of an image that should be saved as JPEG

balance between the quality and file size of the image. When you’re happy with your

result, click Save and give your image a filename.

If you tried the above exercise, you're probably quite pleased with yourself for saving
an image of reasonable quality at a file size significantly smaller than the original.
You managed this by altering the settings in the right-hand pane, but what do these

settings actually do?
GIF/PNG-8

B colors
Adjusting this setting reduces the number of colors used in the image. This will

usually make the biggest difference in the final image.

B dither amount and type (No Dither, Diffusion, Pattern, Noise)
This setting has nothing to do with being nervous or agitated (although it’s
quite possible that you may have been a few moments ago!). Dither refers to
a compression technique in which the pattern of dots is varied to give the
illusion of a color gradient. Changing the dither will result in a more noticeable

degradation for images that involve a large number of colors blended together.
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B transparency

If you want transparent areas in your graphic, check this box. We’ll look more

closely at transparency in Chapter 2.

B matte color
For transparent images, the matte color is used to help blend the edges of your
image into the background of the web page. For non-transparent images, the
matte color defines the background color of the image. Using matte color with

transparent images is covered in more detail in Chapter 2.
JPEG

B quality
Changing the value in the Quality drop-down box alters the level of compression
for the image. Reducing the quality may result in blurring or pixelation, but too
high a setting will produce a large file that will take users too long to download.
A good approach is to decrease the quality value gradually until you notice the
degradation of your image becoming unacceptable. A reasonable compromise

will be somewhere around this point.

optimized image preview

Save For Web - Powefed By ImageReady
Criginal | Oprilfized Y 2.0p La4Up 2

b€

G x| e[ 2[d
# Seedtive  [w]Ql  colori 2] 25 [w]
Difiion | % Githers 100% 3 0]
The sacred lamp of day & S [ ensparency s ]
Now dipt in western IR || o ooy . [g] w05 |

[Jrwedaced WebSnapt 0% 3|

Ol ~»

clouds his parting day:

Color Table :

1]
GIF 100% dither D
2145k Selactive palette - -
77 sec @ 288 Kbps 256 colors = e a 8 @
ontimized-file size
optimizea-tHe size [t el <] o] e
[wo% [w][Ri - & - B - Akha - Hew < det - | @ [:] Ediit in ImageRead

Save For Web dialog box
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Saving Files for the Web in ImageReady ' x|

H Dplimize\‘\Layer Comps i
You can optimize images for the Web in ImageReady using | preset: gL

18

the Optimize palette, shown at right. Set the file type and

7 Color Table

options in the Optimize palette in advance, and when Reduction: [selective || (O]
you’re ready to export your web image, select File > Save caereif s _aal I3

ek Snap: -
Optimized or press Ctrl-Alt-S (Command-Option-S on a Mac). o

ImageReady will save the image based on the settings ol
Amount: | 100% |v]

=7 Transparency

Transparency Matke: | bt |
Dither: |Mo Dither |4 |

Armouints | 1003

that you’ve defined.

TIP Why Two Tools?

=7 Dptions

[interlaced Loszy: | 0 w I

[use Unified Colar Table

[#]add Metadata | Settings...

Considering that it's possible to save files for the Web in Photoshop,
it's perfectly reasonable for you to wonder why ImageReady even
exists! While it's true that both programs can perform many of the
same tasks, there are certain things that ImageReady can do that
Photoshop can't, for example, creating animated GlFs. ImageReady
also makes web-specific tasks easier, and since it's a smaller
program that doesn’t contain the full suite of Photoshop effects, it
loads more quickly than Photoshop. As you work through this book
you'll come to learn which tool is more suitable for particular tasks.

Optimize palette in ImageReady

Photoshop Layers

Layers are a powerful feature of

Photoshop that allow you to work

on one part of an image without

. s
The sacred lamp of day B

disturbing the rest of it. While the Now dipt in b,

clouds his parting day.

concept of layers may seem
intimidating at first, once you get
the hang of using layers you’ll
wonder how you ever survived
without them! The examples on the
next page show how the layers in
the Photoshop document to the right
stack together.

Layered Photoshop document

The transparent parts of any layer, shown

by the checkered grid, allow the layers beneath that layer to show through.

You can show and hide each layer in an image by clicking on its corresponding

eye icon in the Layers palette, as shown at the bottom of the following page.
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S]]
| Layers channel \paths ™. )
[ Mormal [v|opacity: | 200 [»

Lock: O #+4 @ Fill: | 1000 [ » |
v O title
Sunset Sky

E black bar

v (3 text

The sacred lamp of day ...
|

F o
‘E‘|’. Background ]

= 6.0 &0 & F]

o o/ o o &/

The layers in a layered Photoshop document

To organize your layers, you can arrange them into layer groups by going to Layer >
New > Group.... Each layer group displays in the same way as any ungrouped layers
on the Layers palette. A layer group is signified by a folder icon. You can collapse or
expand layer groups by clicking on the triangle to the left of the folder icon, and nest

layer groups within each other by dragging one folder icon into another.

@ 003-layerssplitapart2.psd @ 66.7% (Layer 1, RGB/8%)

=
| Layers Ghannek WRaths S O)
| Mormal [+ |opacity: [ 5w [» ]
Lock: [ 4 @ Fil: [ 100% > |

®|vy B tte

Sunset Sky
==
D black bar

v @ text

The sacred lamp of d...
E oo
- Background a

55 6.0 © 5 & F

The
Now dipt in
clouds his

9] 91

[l

9

9

Doc: 1,37M/3,65M

Hiding a layer

Layer Shortcuts and Tasks

B Rename layers by double-clicking on the layer name.

B Change the transparency of a layer by changing its opacity with the Opacity
slider, or typing a value into the Opacity box (which is visible when you have the

Selection, Move, or Crop tools selected).
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Duplicate a selected layer by pressing Ctrl-J (Command-J on a Mac). You can also
duplicate a layer by dragging it while pressing the Alt (Option) key.

Select multiple layers by holding down Ctrl (Command on a Mac) and clicking the
layer names. This forms a temporary link between the selected layers that allows
you to move them as one unit, delete them all, and so on.

You can also link layers together. Select layers by clicking on them while holding
down Shift or Ctrl (Command on a Mac). Once you have selected all the layers you
wish to link, click the Link Layers button at the bottom-left of the Layers palette
(signified by the chain). Linking layers allows the link relationship to remain
even after you select a different layer (unlike the process of simply selecting
multiple layers).

To unlink all the layers, select one of the linked layers and go to Layer > Unlink
Layers. To unlink a single layer, select the layer you wish to remove from the
link and click its corresponding link icon; the other layers will stay linked. To
temporarily unlink a layer, hold down Shift and click on its link icon (a red “X”
will appear over the link icon). Reactivate the link by holding down Shift and
clicking the link icon again.

Rearrange layers by dragging the layer above or below other layers. Use the
“move down” shortcut Ctrl-[ (Command-[ on a Mac) and the “move up” shortcut
Ctrl-] (Command-]) to move selected layers up and down. Shift-Ctrl-[ and Shift-Ctrl-]
(Shift-Command-[ and Shift-Command-] on a Mac) will bring layers to the very top or
the very bottom of the stack.

Select a layer by using the keyboard shortcuts Alt-[ and Alt-] (Option-[ and Option-]
on a Mac). These keystrokes let you move up and down through the layers in the
Layers palette.

Create a new layer by pressing Shift-Ctrl-N (Shift-Command-N on a Mac). This will
bring up the New Layer dialog box. Want to create new layers quickly without
having to deal with the dialogue box? Simply press Shift-Ctrl-Alt-N (Shift-Command-
Option-N).

Merge a layer into the one beneath it by pressing Ctrl-E (Command-E). If you have

selected layers, this shortcut will merge those selected layers together.

Order the print version of this book to get all 286 pages!
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TIP Quick Keyboard Shortcuts

Naturally, most of the tools in the toolbox have a keyboard

shortcut. You can learn each tool's shortcut by hovering your Q@‘;
Cl..II’SOI’ f)ver a tool for a few seconds:.a tooltip box will :-arl)pear, Pl *l@
displaying the name of the tool and its shortcut. If additional o

tools are available in the flyout menu, you can cycle through P2

them by pressing Shift-[keyboard shortcut]. Keyboard shortcuts % g

can save you valuable time—pressing “V" to bring up the Move \; @:

Tool is certainly a lot quicker than moving the cursor over to the k. T,
toolbox to select it. It may not seem all that significant right ¢|' 2

now, but the time you take to access tools will add up over the
course of a project! For your convenience, whenever | mention a

tool, I'll list its shortcut in parentheses, e.g., the Move Tool (V). Tooltip for a keyboard shortcut

Photoshop Toolbox

You’ve probably been hanging out to get stuck into the very nifty Photoshop toolbox.

In this section, I'll introduce some of the most frequently used tools found in the
toolbox. I'll discuss some of the other tools in later chapters as we apply them to

solutions.

You’ll notice that some of the tool icons have small black g

triangles in their bottom right-hand corners. These icons [ » {7} Rectanguier Margues Tool M
. . . . . & O Elliptical Marquee Tool M
contain hidden treasures! The triangle indicates that g == Singls Row Maryses Tool
. . . i Single Column Marquee Toal
there are more related tools available; if you click on the ‘f’ . |
tool icon and hold it down, a “flyout” menu will appear, o
displaying the additional tools. Finding the "hidden" tools

Selection Tools

You can use the selection tools to select certain

NOTE Secret Selections

Selections can have varying levels of transparency, areas of your document for editing. If you use

known as the degree of opacity. It's actually possible to . ,
. . : a selection tool, only the area that’s selected
make a selection with an opacity of 100% in one area,

but only 20% in another area. If a selection contains will be affected by any changes you make. You
any pixels for which the opacity is more than 50%,
they will be displayed with a border of dotted lines.
Photoshop won't visibly outline areas with less than

50% opacity (though they will still be selected).

can “feather” selections (specify a fuzzy radius
for them) using the Feather field in the options
bar. The example at the top of the next page

shows two rectangles: one created by filling
Selection tools automatically select at 100% opacity.

We'll learn about creating transparent selections using
Quick Masks and alpha channels later in this chapter.

in a selection with a feather of zero pixels,

and one that’s created by filling in the same

selection with a feather of five pixels.

Order the print version of this book to get all 286 pages!
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T - | (2R & (Feather| s px rtialias | Stylet [Nomal

N ) Untitled-5 @ 100% (Layer 1, RGB/B) =

S| <

" -

12( > \__“J‘ = [“}Rectangular Marguee Tool M
‘59 / & (OEliptical Marquee Tool I
WL, 11 ==a Single Row Marguee Tool

r%, ?" y i Single Column Marguee Tool
2.0 i m o 150 4K/212.5K___[P] 9 \

). & Y
"Fuzzy" edges with feathered selections Marquee tools

Marquee tools (M) are used to create rectangular or elliptical selections, including
selections that are “single row” (one pixel tall, stretching across the entire width of
the document) and “single column” (one pixel wide, stretching through the entire
height of the document). To make single-row or single-column selections, click with

the appropriate tool on the image area where you want to select a row or column.

You can use the Lasso tools (L) to create freeform selections.

Lod, P

1
The Lasso Tool comes in three different forms: | = g Lasso Tool L
o 4 Palygonal Laszo Tool L

59 & Magnetic Lasso Tool L

2 5|

B Lasso Tool (L)
Click and drag the Lasso Tool to draw a
selection area. Releasing the mouse button Lasso tools

will close the selection by joining the start and end points with a straight line.

B Polygonal Lasso Tool (L)

NOTE No Selection Sometimes Equals

Click at different points to create

All Selected

vertices of a polygonal shape.

Close the selection by moving If you've made a selection, only the pixels within the selection

your cursor to the beginning and are active and can be worked on. Some tools can be used without

L . making a selection at all. However, be aware that if you have

clicking once, or pressing the not made a specific selection, Photoshop will assume that you

Enter key. are working on the entire layer and any changes you make will
affect all pixels in the layer.

B Magnetic Lasso Tool (L)
If you think you need help with making your selection, try the Magnetic Lasso
Tool. Photoshop will attempt to make a “smart” selection by following the edges
of contrast and color difference. Click once near the “edge” of an object and
follow around it—Photoshop will automatically lay down a path. You can also
click as you follow the line to force points to be created on the path. Close the
selection by pressing the Enter key or clicking at a point near the beginning of the

selection. The Magnetic Lasso Tool is not available in ImageReady.

Order the print version of this book to get all 286 pages!
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LN & 010-magicwand.psd @ 100% (Layer 1, RGB/8) =) |
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f Z
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Using the Magic Wand to create a selection

Magic Wand

The Magic Wand Tool (W) selects areas of similar color. You can change the tolerance
(how close the color values should be to the sampled color in order to be selected) of
a Magic Wand selection, and choose whether you want the selection to be contiguous
(pixels that are touching) or not (in which case, matching colors across the entire

document will be selected).

TIP Selection Shortcuts and Tasks

Hold the Shift key to add another selection to the first.

Hold the Alt key (Option key on a Mac) to subtract your new selection from the first.

Hold Shift-Alt (Shift-Option) to select the intersection of your first and second selections.

Use the arrow keys to move the selection pixel by pixel. If you feel that this doesn't move your
selection quickly enough, hold down Shift and use the arrow keys to move the selection ten pixels at

a time.

Press Ctrl-J (Command-J on a Mac) to copy the selection into its own layer.

B To cut the selection into its own layer, press Shift-Ctrl-| (Shift-Command-J). If this seems familiar to
you, it's because | mentioned earlier how to copy a layer using the same keyboard shortcut. Now
that you know that not selecting anything sometimes means that everything is selected, it makes
sense that simply by selecting a layer in the Layers palette, you can copy the entire layer by pressing
Ctrl-J (Command-)).

B To deselect a selected area, click outside of it with one of the Marquee tools, or press Ctrl-D
(Command-D on a Mac).

B To reactivate your last selection, press Shift-Ctrl-D (Shift-Command-D).

The Move Tool

The Move Tool (V) moves a selected area or an entire layer. You can invoke the Move
Tool temporarily when using most other tools by holding down the Ctrl key (Command
key on a Mac).

Order the print version of this book to get all 286 pages!
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TIP Move and Copy Shortcut

For most tools, holding Ctrl-Alt (Command-Option on
a Mac) and dragging a selected area will temporarily
invoke the Move Tool, allowing you to move and

duplicate the selected layer quickly.

The Move Tool in action

You can also duplicate a layer by holding down the Alt key (Option key on a Mac)

while using the Move Tool, as shown in the image below.

A'E0(]l'i-layerssplitaparlZ.|:|sd @ 66.7% (Layer 2, RGB/BZ)

\-/o/ed

g0
| Layers Channels \Paths . ()

| Mormal [v|opadty: | 209 [»
Lock: [ & -+ @ Fill:| 100% [» |

@y B tite

Sunset Sky
E black bar

v 3 text

The sacred lamp of d...

|
e

EI box

|§ - Background a

= 6.0 .0 & ]

Sunset Sky

Now

o ]

Cll

Cll

Ll

box copy

ql

66,670 Doc: 1.37M/4,16M

Copying a layer with the Move Tool

The Crop Tool

The Crop Tool () is used to trim images.
Create a selection using the Crop Tool,
then double-click the center of the
selection, or press Enter, to crop the image

to the size of the selection.

To cancel without cropping, select another

tool or press the Esc key.

Creating a selection using the Crop Tool Cropped image



http://www.sitepoint.com/launch/650367/

16 The Photoshop Anthology

TIP Crop Outside the Box

You can use the Crop Tool to resize your canvas. Expand your document window so that it's larger than
the image area, and create a crop selection that includes the image and extends onto the gray areas
"outside” the image. Applying this crop will resize your canvas to include those extended boundaries,

making your canvas larger.

Drawing and Painting Tools

Apart from its extraordinar ; :
P Y N AN
photo editing abilities, the multi- Tk 3 b |
. A K
talented Photoshop also provides : E 2| i_z A
drawing and painting tools that &l F| n #BushTod B #. 4|
%‘ .  Pendl Todl B é‘ # |
allow you to create your own o | b T EE e £ @) = ordert Tool 6
% @‘ (. &>, £ Pant Bucket Tool G

i

shapes and backgrounds.

Drawing and painting tools

Brush
v |Brush: 1.3|E| Mode: | Normal  [+] Onacitv:lwo%[»l‘FIDW: [100%[p] #£
Master Diameter 13 o | ®
- : o The Brush Tool (B) is suitable for soft-
e | edged painting or drawing. Draw strokes
a by clicking and dragging the mouse over
; — 2 the canvas. You can change the brush
3 i size and other settings in the options bar
i b -ic at the top of the window.
5 —— |
i
19 v
Brush options
Pencil

The Pencil Tool (B) is suitable for hard-edged drawing or painting and has similar
options to the Brush Tool for setting its size, opacity, and more. The Pencil Tool is

often used for drawing on, and editing individual pixels in, zoomed-in images.

Eraser
The Eraser Tool (E) removes pixels from the canvas. You can choose between Pencil,

Brush, or Block mode from the Mode drop-down menu in the options bar.
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NOTE Aliased vs Anti-aliased

Unlike the Brush Tool, the Pencil Tool's edges
are aliased. The term aliased refers to the edges

of an object being “jagged,” in contrast to an M
anti-aliased object, in which the edges are
“smooth." In the two examples shown here, the
top shape in each example was created using the
Pencil Tool, while the bottom shape was created
using the Brush Tool. Notice the difference in .

the "jaggedness” of the edges of these curves. .

We'll look more closely at anti-aliasing when we

discuss the Text Tool.
Aliased vs anti-aliased lines

Paint Bucket

The Paint Bucket Tool (G) fills a selection with a flat color. To use the Paint Bucket Tool,
click once in the area that you wish to fill. If the chosen area is not within a selection,
the Paint Bucket Tool will fill all similarly-colored pixels within the vicinity of the

clicked area.

Gradient

| Mode: | Mormal  [s] Opacity: | 100% [ | | CReverse [FDither [7 Trarsp:

Gradient options

The Gradient Tool (G) fills a selection with a blend of two or more colors, known as a
gradient. You can easily create your own gradient, or use any of the preset gradients

available in Photoshop.

Display the gradient presets and tools by clicking on the small triangle on the right-
hand side of the Gradient Tool. Apply a gradient by setting your desired colors,
choosing your gradient style, then clicking and dragging the cursor over the area to

be filled.

The Gradient Tool is not available in ImageReady.


http://www.sitepoint.com/launch/650367/

The Photoshop Anthology

I find that I use the first two gradients—the foreground-to-background gradient,
and the foreground-to-transparent gradient—most often. The former will blend
your foreground color into your background color, while the latter will blend your

foreground color into a transparent background, giving it a “fading out” effect.

Text Tool

The Text Tool (T), true to its name, creates text layers. This one’s easy to use—just
select the Text Tool, click on the canvas, and start typing! You can also click and drag
to create a rectangular text area that will force text to wrap within its boundaries.
You can change the font size, color, and other text properties using the options bar

along the top of the window.

When the Text Tool is active, you can move the cursor outside of the text area. The
cursor will change from the “text insert” cursor to the “move” cursor, and you’ll be

able to move the text layer around.

It’s worth noting that when the Text Tool is active, you can’t use keyboard shortcuts
to access other tools. This may seem like an obvious thing to point out now, but it
won’t always be so apparent—especially when your text mysteriously starts spurting

strange characters because you’ve been trying to use the shortcut keys!

To finish using the Text Tool, press Ctrl-Enter (Command-Return on a Mac). You can then

resume your regular keyboard shortcutting!

Shape Tools
You can create shapes simply by clicking and dragging Photoshop’s Rectangle,
Rounded Rectangle, Ellipse, Polygon, Line, and Custom Shape tools (U).

The specific options for each shape tool are displayed in the options bar, and you
can access additional options by clicking on the arrow to the right of the Custom
Shape button. For example, the Line Tool has options for displaying arrowheads, and
for controlling the shapes and sizes of those arrowheads, as shown in the example

below.

If you look at the options for each R = PR = [

Arrowheads
[¥]start Clend
Width: | 500%

shape, you’ll notice that there are o
Shape layer Fill pixels

three different methods you can Path only

Length: | 1000%

use to create a shape: concaty: | 0%

Shape options

Order the print version of this book to get all 286 pages!
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B as a shape layer (default)
Your shape will be created | Ho19-hapeaptionsexampte psd @ - [LJEE| |y, - ~ammen =

| Morrnal Cpacity: | 100%
Lok & &+ & Fill: | 100
i 9] Layer 1 |
& . 8 I shape 1

&)

as a solid-colored layer

covered with a vector shape
mask. Confused? Think of
the mask as a sheet of dark o0
. W paths o)
paper that has a hole (your shape) cut out of it so that the | g wansen ;
color shines through the hole. To change the color,
double-click on the color block in the Layers palette

as shown in this example. To change the vector shape

i
= [ gackeround a

100% | ™

|
_ @ 0 O A& &l @4

mask, use the vector editing tools. Different ways to create shapes

B asa path
Your shape will be created as a path in the Paths palette, as shown in the example

above (in which the path has been named Work Path).

B as filled pixels
Your shape will be created on whichever layer is currently selected. I created a

new layer, then created a shape using the Fill pixels option on Layer 1 in the above

example.

Selecting Colors
Set foreground and background colors by clicking on the appropriate tile and

choosing a color from the Color Picker, as demonstrated in the example below.

Lk
= l"\ Color Picker u
M Select foreground color:
e .%
& & -
0.6 -
%, T, J@H: (233 |*  OL: 25:
0.0, Osi[74 % Oai[z |
B.7 Osi (57 % Obi |5 |
foreground —_ 4 ?: o L J
y O (51 |
background— Op: 145 ]
. #!26.3;.1
[El=1=] [[Jonly web Calors
TN |

Selecting foreground and background colors using the Color Picker
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TIP Color Picker Eyedropper
Shortcuts The Eyedropper Tool (/) lets you sample another color from

your image, and set this as the foreground color. In fact, it’s

Press X if you want to switch
the foreground and background

actually possible to sample colors from anywhere in your

colors. Press D if you want to display and even from other applications outside of

revert to a black foreground and Photoshop. Simply click inside the document window, then

white background. drag the cursor to the color you wish to sample. Click to
T —

select that color.

The Eyedropper Tool also allows you to set the background color. To do so, hold
down the Alt key (Option key on a Mac) as you select colors using the eyedropper. If
your Swatch palette is open, use the Ctrl key instead (Command key for Mac users).

The Paint Brush, Pencil, Paint Bucket and any of the other painting or drawing tools

can temporarily be turned into the Eyedropper Tool by holding down Alt (Option).

The Hand Tool

The Hand Tool (H) moves your canvas, which is handy (pardon the pun!) when

you’re zoomed in to an image, or have a very large document open.

What’s even handier is the fact that you can invoke the Hand Tool while you’re using
any other tool (except the Text Tool) by holding down the spacebar. This is a neat
way to position your image exactly where you want it without having to chop and

change between tools to do so.

Other Useful Tasks and Shortcuts

Zooming
Zooming right into your image is the only way to make subtle changes at the pixel
level. Use Ctrl + to zoom in and Ctr/- to zoom out. You can also zoom using the slider

on the Navigator palette.

Making a Selection Using the Layers Palette

To select the pixels on a particular layer, press Ctrl (Command on a Mac) and click the
thumbnail of the layer. This selection will also take into account the transparency
of any pixels, so painting in the selection will recreate the transparency settings of
the original layer. The example at the top of the next page shows a selection I made

based on one of the text layers in my sunset document.

Order the print version of this book to get all 286 pages!
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Creating a selection based on a layer

Making a Selection Using a Quick Mask
Quick Masks are one of those closely guarded trade secrets that professional
designers use all the time, but beginners often are wary of trying because they seem

complicated at first. Well, they’re not!

A Quick Mask is an alternative way of making a selection. The usual way to use a
Quick Mask is to go into Quick Mask Mode (Q) and, using a tool such as the Brush
Tool, painting the things you don’t want to select. This is called painting a “mask,”
and the resulting reverse-selection will display as the transparent red color that you
can see in the example overleaf. You can edit this red layer—honing the mask shape,
for instance—using the drawing and painting tools. Those alterations won'’t affect
your image, though: they impact only on your final selection. Switching back to

Standard Mode (Q) will complete your selection.

Why would we use this technique instead of those trusty selection tools that we’ve
all come to depend on so heavily? Well, Quick Masks have a couple of advantages

over the standard selection tools:

1 They allow you to control the level of transparency of your selection.

2 It’s easier to color an object in, than it is to carefully draw a line around it.

Initially, it can be difficult to get your head around the fact that you aren’t painting
on your image: you're just painting the selection. But once you master that concept,
you’ll feel confident to be able to make a selection quickly on any shape, no matter

how difficult it seems!
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v E 003-layerssplitapart2. psd @ 66.7% (The sacred lamp of day Now d. Q... [._HEIE

ﬂ

i
Sunset Sky E‘ -
FY
&, Z,
- E |
B,
k., T,
i‘.gi
E g
) oQ

L-.‘
&

Standard —E\-
Mode 5 |

'Fjb'!l

Coc: 1,.37M/3,90M

Painting a reverse selection in Quick Mask Mode Returning to Standard Mode

TIP Quick Mask Options

Quick Mask Options
| prefer to set Quick Mask Mode so that it lets me — Color Tndlicates:
paint in the selected areas rather than the non-
selected areas, as shown in this example. To alter
your settings to do the same thing, double-click

on the Quick Mask Mode icon and change the - s
Color Indicates: option to Selected Areas.

Cancel

The Quick Mask Options dialog

(=Jojed

@ 003-layerssplitapart2. psd @ 66.7% (Background, Quick Mask/B)

Sunset Sky

The se
Naw dipt in
clouds his

Painted areas are now selected areas
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Alpha Channels and Selections

You can use alpha channels A alphaexample psd @ 100% (Layer 1, RGB/3) mE ¥

=]

ILayers ¥ Channels Sathe S " ()
Ctrles

to create selections and save

them for later use. If you open
the Channels palette, you’ll see Ctrl+1

Ctrl+2

L] i Blue Ctrl+2

several channels, displayed
in a similar way to layers in
the Layers palette. By default,
you’ll see the color channels,
which represent how much of

each color is represented in the

document. You can click the ] % 3
Create New Channel icon at the T T R
bottom of the palette to create .

Creating a new alpha channel
your own alpha channel.
You can then use any of Photoshop’s F alphaexample.psd @ 100% (Lav.. |- DS —
painting or drawing tools to create a Tiapeia Crannels “Salbe i

‘ RGB Citlee

7ig Red Ctrl+1
7|H Green Ctrl+2
—‘ﬁ Elue Ctrl+3
;‘n Alpha 1 Ctrl+4

grayscale image that will represent
your selection—white areas
represent selected areas, black areas
represent deselected areas, and grays

represent the levels of transparency

in the selection. O s
100% ||  Doc: 468.8K/600.3K ¢
Creating a grayscale image
To turn your alpha channel masterpiece W alphaexample.psd & 100% (La... |- JCJES —
into a selection, simply hold down Ctrl TisiersY Channels “Sathe e

RGE Ctrlte

|g Red Ctris1

-
Green Ctr+2
i ‘i Blug Ctrh3

El ‘q Alpha 1 Ctrl+4

and click the channel’s thumbnail (hold

Command and click if you’re on a Mac).

100% | 5] Doc: 468.8K/600.3k I

Creating a channel-based selection

To return to the normal image view, click on the Layers palette tab, and select any

layer. Your selection will still be visible.

Order the print version of this book to get all 286 pages!
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A alphaexample. psd @ 100% (Layer 1. RGB/B)

(o)
| g0
Layers " channels WPaths S
Mormal [ [Oparity:

Lock: O #+4 @ Fill:

= &.0 ®©. 0 & %[

100% | Doc: 468.8K/600.3K

Returning to the Layers palette

You can also create your own alpha channels from existing selections—a capability
that can be very useful! For example, let’s say you’ve created a selection of an island
silhouette like the one shown in the example below. You have a feeling that you’ll
be reselecting this island pretty often, but you’d rather not recreate the selection
each time. No problem! Once the selection has been made, use Select > Save Selection.

Name your selection (in this example, Land), and click OK.

A alphaexample.psd @ 100% {Layer 1, RGB/1) _= u‘
]

Save Selection u
= =
J

Channels Baths™e "

RGB Chrl

— Destination [ 0K

Document: | alphaexarmple.psd

Cancel

=[x

Channel: | e Red Chr+1

Marme: | Land| |

Green Ctrl+2

— Dperation
& New Channel

Add to Channel
Subtract from Channel
Intersect with Channel

Blue Ctrl+3

Alpha 1 Ctrl+4

Doc: 468,8K,/600,3K

Saving the selection to a channel

If you go to the Channels palette, you'll see a new selection at the bottom of the list,
named Land in the following image—that’s your saved selection. Now you can reload

your Land selection as many times as you need to!
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‘i‘alphaexample.psd @ 100% {Layer 1. Land/B) g@

ILavers | Chanmels  Daths o

‘ RGE Chrl+e

| g Red Cerl+1
Green Ctrl+2
| i Blue Ctrl+3
- \n Alpha 1 Chrl+4
Q ! Land Ctrl+5

100% | )| Doc: 468.8K/756.5K »

New channel in Channels palette

The History Palette

The History palette is your key to time travel (in Photoshop, anyway). It lists the most
recent steps that you’ve made, and allows you to undo your actions by rolling your
image back to a previous state. You can set the number of steps that are stored in the
memory by selecting Edit > Preferences > General (Photoshop > Preferences > General on

a Mac) and changing the value in the History States text box.

Like most of Photoshop’s other tools, the History palette has a set of useful keyboard

shortcuts for quick access:

B Ctrl-Z (Command-Z on a Mac) lets you undo and redo the previous step.
B Ctrl-Alt-Z (Command-Option-Z) steps back through the History palette.
B Shift-Alt-Z (Shift-Option-Z) steps forward through the History palette.

As only a limited number of history states are available, — "%,

History “&ctions S0 Dl
there may be cases in which you want to save a e

|
“snapshot” of your document so that you can revert back '
e Snapshot. .

to it later if required. To do so, click on the small e %
triangle on the top-right of the History palette and ——
choose New Snapshot.... You can save a snapshot of the Hetan DRt
whole document, the current layer, or merged layers. Creating a history snapshot

When Photoshop Stops Working
Woah! Photoshop stops working? That certainly doesn’t sound too promising! Before

you panic, let me explain. Given the multitude of powerful features and fantastic

Order the print version of this book to get all 286 pages!
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tools it offers, it’s no wonder that, on occasion, Photoshop can exhaust itself. It may
start behaving a bit erratically, and might even freeze, crash, or automatically exit
during startup. If you find yourself in this situation, the first thing to do is reset the
preferences file. The preferences file (which you can customize by going to Edit >
Preferences on a PC, or Photoshop > Preferences on a Mac) holds Photoshop settings

and can often become corrupted.

The location of the preferences file . .
TIP Backing Up Your Preferences File

depends on the operating system and

version of Photoshop you are using. For It's a good idea to back up your preferences file by

Photoshop CS2, the preferences file is copying and pasting it into a location outside of the
Photoshop settings folder. Then, if the preferences file
Photoshop is using becomes corrupted, you can copy
your backup back into the settings folder to replace the
corrupted file, without losing any of your settings.

named Adobe Photoshop CS2 Prefs.psp.
The preference file for other versions of

Photoshop will have a similar name.

To reset the preferences file, locate the current preferences file, delete it (while
Photoshop is closed), and restart Photoshop—it will recreate the preferences file
using default settings. Creativepro.com provides a detailed tutorial® that explains
how to find and replace your preferences file, and includes preference filenames for

different versions of Photoshop.

If Photoshop continues to act up, restart it while holding down the Shift-Ctrl-Alt keys
(Shift-Command-Option on a Mac), and click OK when asked if you wish to delete the
Photoshop settings file. Unfortunately, this will also delete your custom actions,
tools, and other settings, but the good news is that it should fix your Photoshop

problems.

Summary

This chapter provided an overview of the Photoshop and ImageReady interfaces and
common tools, and also explained a few basic tasks such as creating new documents
and saving files for the Web. You also took a quick tour of handy keyboard shortcuts
and other time-saving tips. Even if you haven’t used Photoshop before, you now have
the tools that you’ll need to work with the examples we’ll discuss throughout the
rest of this book.

1 http://www.creativepro.com/story/feature/17478.html

Order the print version of this book to get all 286 pages!
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What's Next?

If you’ve enjoyed this chapter from The Photoshop Anthology, why not order

yourself a copy?

SitePoint’s first full color book, The Photoshop Anthology: 101 Web Design Tips,
Tricks & Techniques provides you with over 100 tried and tested real-world
Photoshop solutions for you to use on your projects. If you’ve ever been stuck for
inspiration, or have puzzled over just how to create that shiny “Aqua” style button or
that seamlessly tiling background image you saw on a web site recently, you need a

copy of this book.

Author Corrie Haffly has drawn on her extensive Photoshop experience to show you
how to create a multitude of web graphics, ranging from buttons to backgrounds

to other user interface elements. Corrie also covers ways to greatly improve your
workflow and make working with Photoshop more efficient through batch processing

and the automation of repetitive tasks.

Following the same step-by-step, problem-and-solution format used in other
SitePoint Anthology books, this book is packed with best-practice, innovative and

visually stunning techniques to produce amazing graphics for your web sites.

The book’s full color layout and larger than normal size (8" x 10”’) were especially

designed to help show off the techniques demonstrated in the book.

The Photoshop Anthology: 101 Web Design Tips, Tricks & Techniques also includes
download access to all of the Photoshop (PSD) files used in the book—that’s over

50MB of files—so you can use them right away in your projects.
In the rest of the book, you’ll learn how to:

e Master the basics: image sizing, layers, vector shapes, transparency, and more.

e Create a multitude of different buttons: aqua-style, metallic, glassy, and more.

e Create seamless tiling backgrounds: rice paper, brushed metal, granite, and more.

e Work with text: style it, create special effects, wrap it around 3D objects, and more.
e Touch up photographs, match colors, and combine different images.

¢ Use eye-catching special effects.

e Isolate objects from images.

Order the print version of this book to get all 286 pages!
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* Make graphics for CSS rollover buttons.

* Design an entire web site and easily switch between different versions.

e Optimize graphics for web use.

e Work smarter: automate your workflow with batch commands and actions.
e Create animated GIFs.

¢ And lots more ...

On top of that, order direct from sitepoint.com and you’ll receive a free Hexadecimal

Color Reference Chart (while stocks last!).

Order now and get it delivered to your doorstep!



http://www.sitepoint.com/launch/650367/
http://www.sitepoint.com/launch/650367/

Index

A

actions, 253—-254, 257
batch processing, 255
saving sets of, 259-260
watermarking multiple
photos, 258
Actions palette, 253-254, 257—
260, 270
Add Anchor Point tool, 88, 138
Add Layer Mask icon, 44
Add Noise filter, 65, 103, 105,
108, 111
Adjustment Layers Adjustment
Layer (See Curves
adjustment; Hue/Saturation
dialog; Levels dialog)
Adjustment options, 163—165,
174
aliasing, 17
Align Layers to Selection
option, 64
alpha channels, 23-24
(See also Channels palette)
animated GIFs, 266-272
Animation palette, 266-267,
271
anti-aliasing, 17, 54-55, 125
aqua buttons, 70-79
Arrange option, viewing pixel
images, 101
Artwork (See graphics)
Automate menu, 255-256, 262

B

background colors, 19-20
(See also matte color)
blending images, 46
fading images into, 43—45, 50
glass button, 83
pixel backgrounds, 100
transparent backgrounds, 53

background images, 231

backgrounds
(See also tiled backgrounds)
darkening to emphasize

subjects, 152—-154
patterned, 77
transparent, 53, 204

batch processing, 255-257
Bevel and Emboss layer style
buttons, 59-61, 75, 83
engraved text, 130
glassy text, 129
magnifying glass effect, 181,
183, 192-193
beveled buttons, 58-59
Bezier controls (See handlebars)
black-and-white images,
conversions, 158-161,
226-227
black-to-transparent gradients,
45
blacks, improving, 144
blemish removal, 166—169, 222
blend modes, 153—154
adding scanlines, 178
Darken, 168-169
Difference, 97, 224
Hard Light, 216
Lighten, 169
Multiply, 129
Normal, 68
Overlay, 148-149
Screen, 178-179
Vivid Light, 154, 156
Blur filters
Gaussian Blur, 108, 185-186,
Lens Blur, 194
Motion Blur, 103, 105, 134
Surface Blur, 171-172
bounding boxes
button highlights, 73
magnifying glass effect, 180,
183
Polaroid photo effect, 196
reflections, 205
resizing a layer, 32
Smart Objects, 29
transformations, 217
wrapping text, 120
boxes, product, 208-214
Brush Strokes filter, 206
Brush Tool (B), 16
(See also drawing and
painting)
blending images, 46
coloring images, 227
custom brushes, 113-115

darkening backgrounds, 154
dotted coupon box example,
51

removing blemishes, 168

stamp effect with text, 131

wood-grain backgrounds, 107
bullet points, 91
Burn Tool (0), 153-154, 216
buttons

angled-tab, 187—188

aqua, 70-79

beveled, 58-59

chiseled, 59-60

CSS rollover buttons, 250

embedded, 60-61

file folder tab, 90

glass, 83—85

gradient buttons, 61-63

metallic matte, 65—68

metallic shiny, 68-70

pearl, 85-87

plastic, 80-83

reusing, 229

round push buttons, 64

rounded tab, 189

simple, 57-58

transparent aqua, 77-79

C

canvas resizing with the Crop
tool, 16
Canvas size dialog, 177, 247
Channel Mixer dialog, 159
Channels palette, 23—24
black-and-white conversion,
158-159
emphasizing foreground
objects, 193
stamp effect with text, 132
textured stone background,
110
characters, modifying shapes,
137-139
Chisel Hard option, 75, 130,
chiseled buttons, 59-60
circles, creating perfect, 35, 180
clipping masks, 48-50
Clipping Paths, 198
Clone Stamp Tool ()
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Healing Brush Tool and, 222
removing distracting
elements, 220-221
tiled backgrounds and, 93, 96,
109, 111, 116
Clone Tool (§), 97
Clouds filter, 109
collylogic.com, 250
color correction, 141-144,
149-152
color halos, 198-199, 204
Color Picker
gradient buttons, 63, 69
hexadecimal codes for colors,
43
sampling colors, 19, 41
temporary color changes, 138
Color Readout option, 42
Colorize option, 162
colors
(See also background colors)
adding pound sign when
pasting, 43,
coloring a grayscale image,
232-227
Gradient tool, 17
hexadecimal codes for, 42—43,
232-233
matching between images,
162-164
Paint Bucket tool, 17
RGB values, 152
selecting, 14, 19-20, 41
use for visualizing changes,
202
vivid, 147-148
compression
JPEG format)
comps, 2
best practice, 232
experimenting with, 234-236
saving for presentations,
263-266
Constrain Proportions option,
32,207
content area shadow effect,
245-246
contour styles, 83—85
contrast, 144, 156
Convert Point Tool (P), 36,
88-89, 138
Convert to Shape option, 204,
214
corners, rounded, 35—-36, 47, 82
coupon boxes, 51-52
Create New Fill or Adjustment
Layer (See Curves
adjustment; Hue/Saturation
dialog; Levels dialog)
Create Plane Tool (C), 210
creativepro.com, 26

(See dither;

Crop Tool (C), 15-16,
image on a product box, 208
thumbnails, 207, 256—257
web optimized images,
241-242
crop-and-save method, 241-243
CSS
(See also style sheets)
benefits of using, 233
centering backgrounds, 248
rollover button graphics, 250
web-optimized images and,
229-230
curved design elements, 37—-39
curved letters, reflections, 205
curved paths, fitting text to,
126-127
curved surfaces, 124, 214-216
Curves adjustment layer
correcting midtones, 144—146
removing color casts, 150—
152
shadow and highlight detail,
174
vivid colors, 148-149
Curves command, adjustment
layers compared to, 146
custom actions, 256
custom brushes, 113-116
Custom Shape Tool (U), 40, 93,
18
customizations, 257—-258, 261

D

Darken blend mode, 168
Define Brush Preset option, 114
Define Custom Shape option, 40
Define Pattern dialog, 177, 243
Delete Anchor Point tool, 36
designs (See comps)
Despeckle filter, 170
diagonal lines, 35
Difference blend mode, 97, 224
Difference filter, 110
Direct Selection Tool (A),
button designs, 74-75, 82,
87-90
curved design elements,
38-39,
fitting text to a shape, 123,
127
isolating parts of images,
198-199
letter shape changes, 137-138
reflected images, 205
rounding corners, 47
Displace filter, 191-192
displacement maps, 189, 191
Distort filters, 191-192
dither, 7

docking, 3
document dimensions, 5, 93,
229
document resizing, 32
Dodge Tool (0), 154-156, 216
dotted coupon box example,
51-52
drawing and painting tools,
16-18
creating lines, 34-35
editing layer masks, 45
layer masks compared to, 45
Drop Shadow layer style, 53
button text, 74
content area, 246
ecommerce product photos,
218
glass buttons, 85
glassy text, 128
magnifying glass effect, 186,
192
pearl buttons, 87
Polaroid photo effect, 196—
197
text effects, 135
transparent aqua buttons, 78
droplets, 256-257
Dune Grass brush, 115-116
Duplicate Image dialog, 241
Duplicate Layer action, 201
Duplicates Selected Frames
button, 267
Dust and Scratches filter, 167,
169

E

ecommerce photos, 216-219
Edge Highlighter Tool (B), 200
edges, removing from joined
images, 226
Ellipse Tool (U), 180, 182
embedded buttons, 60-61, 74
emphasis, parts of images, 193—
195, 216-218
engraved text effect, 130
Eraser Tool (E), 16, 202
(See also drawing and
painting)
error logging, batch processing,
257
Extract filter, 200, 203
Eyedropper Tool (/), 20, 41
(See also Measure Tool)

F

fading an image, 43—45, 50
combining images, 46, 166
reflections, 205

Order the print version of this book to get all 286 pages!
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fading text in animations,
269-271
feathering selections, 12-13
file opening and saving, 5—6
file size, status bar, 4
Fill dialog, 189-190
Fill Pixels options, 19, 62
Fill Tool (G), 200
Filter gallery dialog, 112
filters
(See also Blur; Brush Strokes;
Distort; Extract; Liquify;
Noise; Other filters; Render;
Sharpen: Texturizer;
Vanishing point)
Spot Healing Brush Tool and,
167
unconventional uses of,
192-193
Flash
exporting animations to, 272
saving objects for, 204
transparent PNGs and, 7
web photo galleries, 262, 265
Flip Vertical transformation, 82
Flop option, 213
foreground colors, 19-20
foreground elements, unwanted,
220-221
foreground objects,
emphasizing, 193—-195
foreground-to-background
gradients, 18, 61
foreground-to-transparent
gradients, 18, 44
Free Transform command,
33-34,73

G

Gaussian Blur filter, 185-186,
192
GIF format, 6
animated GIFs, 266—272
color setting, 7
dither, 7
saving a logo as, 238
transparent backgrounds, 54
transparent GIFs, 99
glass buttons, 83-85, 86
gradient buttons, 61-64
Gradient Editor
button designs, 63, 69, 71-73,
78
magnifying glass effect, 181
Gradient Overlay layer style
button designs, 63, 69-70, 72,
78, 80
applying to text, 136
Gradient Tool (G), 17
blending images, 44

box image reflection, 214
emphasizing foreground
objects, 194

fading an image, 44

gradient backgrounds, 102
gradients

applying to text, 136-137

fading reflections, 205, 214
graininess, 66, 170172
granite backgrounds, 108-109
graphics

(See also images)

CSS rollover buttons, 250

formats, 6

importing, 28-31

when to use CSS instead, 230
grayscale images

(See also layer masks)

black-and-white conversion,

158-160

coloring, 226-227

guides, drawing, 214

H

Hand Tool (H), 20, 199
handlebars
curved design elements,
38-39
tab buttons, 90
warp transformations, 215
Hard Light blend mode, 216
Healing Brush Tool (J), 222
hexadecimal codes for colors,
42-43, 232-233
highlights
aqua buttons, 72
lightening, 154-156
magnifying glass effect, 182
revealing detail in, 174
histograms, 132-133, 143-144,
149-150
History Brush Tool (V), 201
History palette, 25, 201
Hue/Saturation dialog, 147
black-and-white conversion,
160
Colorize option, 162
wood-grain backgrounds, 105

Mlustrator, importing artwork
from, 29

image files, external, 28, 41
image resizing, 30-31, 33
Image Size dialog, 32, 253-254
Image Size option, 207
ImageReady

animations, 266, 272

code from, 250

comparison with Photoshop,
9

off-canvas objects, 267

saving files for the Web, 9,
236

images
(See also photographs)
adding scanlines, 176—179
coloring, 226-227
creating thumbnails, 207-208
Crop tool, 15-16
ecommerce product photos,
216-219
emphasizing foreground
objects, 193-195
enhancing detail, 216-219
fading into backgrounds,
43-45, 50
isolating parts of, 198-204
magnifying glass effect,
179-193
merging, 46, 165-166,
223-226
page accent images, 231
Polaroid photo effect, 195—
197
positioning, 20, 248-249
reflections of, 204-207
removing distracting
elements, 220-221
rounding corners, 47
sharpening, 172-173
superimposing on a surface,
208-214, 214-216
thumbnails for multiple,
253-256
transparent backgrounds, 53
Info palette, 42, 150
Inner Glow layer style, 71, 86,
129, 190
Inner Shadow layer style, 79,
129
Internet Explorer, transparent
PNGs and, 7, 54

J

ﬁuer,114—115
joined images, 46, 226
JPEG format, 6, 8, 254

K

kerning, 121-122
keyboard shortcuts (See
shortcuts)

L

labeling images, 218-219
Lasso Tools (L), 13
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(See also selection tools)
Layer Comps, File Menu
options, 264-265
Layer Comps palette, 234-236,
238, 240
layer groups, 10
layer masks
box image reflection, 214
clipping masks and, 48-50
combining images, 46, 166
fading an image, 44—45
isolating parts of images, 203
magnifying glass effect, 187
removing blemishes, 168
layer styles, 58, 62
(See also Bevel and Emboss;
Drop Shadow; Gradient
Overlay; Inner Glow;
Inner Shadow; Outer Glow;
Pattern Overlay; Satin;
Stroke)
advantages, 75-76
document resizing and, 32
drop shadow effect, 53
saving sets of, 261
unconventional uses, 192—
193
layers, 9-12, 33-34
duplicating with the Move
tool, 15
importing from another
document, 28
masking multiple, 47-50
selecting, linking and
merging, 11
Layers palette, 9-10
Add Layer Mask icon, 44
adjusting transparency, 43
clipping masks, 48-50
resizing a layer, 32-33
selecting pixels, 20
Smart Objects icon, 30
layouts (See comps)
leading, 120
Lens Blur filter, 194—-195
letter shape changes, 137-139
letter spacing changes, 121-122
letters, reflections of, 205
Levels adjustment layer, 104
removing color casts, 149—
150, 152,
shadow and highlight detail,
174,
Levels command, 142, 144
Levels dialog, 132—-133, 141-
142
lighting, matching between
images, 162—-164
Lighting Effects filter, 66, 68,
110
line spacing changes, 120

Line tool (U), labeling images,
218

Linear Light blend mode, 154,
156

lines, creating using drawing
tools, 34-35

Liquify filter, 106

Lock Transparent Pixels option
62, 65

logos, on curved surfaces, 214

Looping Options, Animations
palette, 271

M

Magic Wand Tool (W), 14
Magnetic Lasso Tool (L), 13
magnifying glass effect, 179-193
Maintain Aspect Ratio button,
33
Marquee tools (M), 13, 61
Match Color dialog, 163-165
matte color, 8, 54—55
Measure Tool (/), 209
menu bar, 2—-3
metallic backgrounds, 103—104
metallic buttons, 65-70
midtones, 144
mockups (See comps)
monochrome (See black-and-
white)
Motion Blur filter, 134
Move Tool (V), 14-15
button highlights, 82
cloned photographs, 96
ecommerce product photos,
217
move up and move down
shortcuts, 11
Multiply blend mode, 129,
178-179, 227

N

navigation buttons(See buttons)
Navigator palette, 20
New Layer dialog, 11
Noise filters
Add Noise, 65, 103, 105, 108,
111
Despeckle, 170
Dust and Scratches, 167
Reduce Noise, 170-171
noisy images, improving,
170-172
non-destructive editing, 45, 142,
146, 160, 232
Normal blend mode, 68, 190,
225

0)

object selection and positioning,
198-204, 248—-249
Offset filter, 93—94, 100
opacity
fading text from animations,
271
reducing during alignment,
97, 224
watermarks, 259
Opacity box, 10
Opacity field, 43
Optimize palette, ImageReady,
9, 238
options bar, 2-3
Other filters, 94
Outer Glow layer style, 68, 72,
81, 128
outlining buttons, 57-58
outlining text, 128
Overlay blend mode, 148-149,
152, 178-179

P

Paint Bucket Tool (G), 17, 178,
243-244
painting (See drawing and
painting)
Palette options, hexadecimal
codes for colors, 42
palettes, 2, 4
Path Selection Tool, 40
Paths option, 184, 198
Paths palette
fitting text inside a shape, 123
rounding corners, 47
Shape tools and, 19
Pattern Overlay layer style, 136,
243-244
patterned backgrounds, 100—
101, 247-248
patterned text, 136
patterns, filling areas with,
243-245
PDF slideshows, 265
Pen Tool (P), 360, 214
(See also Add Anchor Point;
Convert Point tool; Delete
Anchor Point tool)
curved design elements,
37-39
fitting text to a shape, 122,
126
isolating parts of images, 198
tab buttons, 89—90
Pencil Tool (B), 16, 65, 99—100
(See also drawing and
painting)
perspective, 95, 211
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photographs
(See also images)
adjusting shadows and
highlights, 174
blemish removal, 166169,
222

converting to black-and-
white, 158—161
color correction, 147-152
contrast correction, 141-146
darkening backgrounds,
152-154
ecommerce sites, 216—219
grain and noise reduction,
170
lightening areas, 154-156
Polaroid photo effect, 195—
197
red-eye correction, 157
rounding corners, 47
sepia toned, 161-162
tiled backgrounds from,
95-98
tone correction, 141-146
watermarking multiple
photos, 258-259
Pillow Emboss option, 60, 75
pixel backgrounds, 100-101,
230
plastic buttons, 80-83
PNG format, 6—7, 204
Polaroid photo effect, 195-197
Polygonal Lasso Tool (L), 13
polygonal shapes, 37
portraits, removing blemishes,
222
PowerPoint, 264
preferences file, resetting, 26
presentations, saving comps for,
263-266
presets, 5, 263
product box, adding an image,
208-214

Q

Quick Mask Mode, 21-22
(See also selection tools)

R

random spots, 131

raster buttons, 62

raster layers, 30, 33

rasterizing
filter use and, 134
magnifying glass effect, 189
Smart Objects, 31
spell-checking before, 135

Rectangle Tool (U), 57, 184

rectangles, rounded corners, 35

Red-eye Tool (), 157
Reduce Noise filter, 170-171
reflections, 204—-207, 212
Render filters
Clouds, 109
Difference, 110
Lighting Effects, 66, 68, 110
repairing images (See blemish
removal)
RGB color mode, 158, 162, 229
RGB values, 150
rice paper backgrounds, 113—
117
ripple effect, 206
rolling back changes, 25
rotating brushes, 52
rotating layers or selections,
33-34
Rounded Rectangle Tool (U), 35
buttons, 57, 62, 80
magnifying glass effect, 180
photo corners, 47

S

Satin layer style, 85
saturation
black-and-white conversion,
160
increasing, 147-148
sepia toned images, 162
wood-grain backgrounds, 105
Save For Web dialog, 7-8
multiple thumbnails, 254
options, 6
tiled backgrounds, 95
transparent backgrounds, 54
web optimized images, 238,
242
Save Optimized As option, 240
Save Selection option, 24
scanlines, 176179
scanned images, merging,
223-226
scattering, 52, 115
scratches, removing, 166—169
Screen blend mode, 178-179
screen size, document
dimensions and, 5
Scripts menu, 164
selection tools, 12—-13
color matching, 163
gradient buttons, 61
Quick Masks and, 21
selections, rotating, 33-34
sepia toned images, 161-162
Shadow Mode color, beveled
buttons, 59
shadows
content area, 245-246

magnifying glass effect,

183-186
revealing detail in, 174
text, 135
Shape Tools (U), 18-19
shapes

fitting text to, 122, 126,
pattern fills, 244
selection with Quick Masks,
21
Sharpen Details field, 170
Sharpen filters, 172-173
shortcuts
Character palette, 121
Color Picker, 20
Hand Tool, 20, 199
History palette, 25
layers, 10-11
Move Tool, 15
opening and saving files, 6
Text Tool and, 18
toolbox items, 12
single row and single column
selections, 13
“slice” effect on text, 132
Slice method, 236-240, 242—
243
Slice Tool (0), 236
slices, 239, 249
Smart Objects, 29-31, 33
snap feature, ImageReady, 237
snapshots, 25
spatter, 131
“special dimensions”, 93, 111
spell-checking, 135, 138
Spot Healing Brush Tool (J),
167, 169, 222
Spotlight Effect, 66
Sprayed Strokes filter, 206
squares, creating perfect, 35
stamp effects, 130-132
status bar, 2, 4
striped backgrounds, 99
Stroke layer style
ecommerce product photos,
218
magnifying glass effect, 181,
183
outlining buttons, 58, 67, 69,
75, 79-80
outlining text, 128
Polaroid photo effect, 195
style sheets, gradient
backgrounds, 102
(See also CSS)
Styles palette, 261
Surface Blur filter, 171

T

tab buttons, 87-90
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text
adding a single line, 119
adding to buttons, 74
aliasing, 125
animations, adding to,
269-271
changing letter spacing,
121-122
changing leading, 120
chiseled or engraved, 130
converting to a shape, 214
curved paths, 126-127
curved surfaces, 124-125
fitting inside a shape, 122—
123
glassy, 128-129
glowing, 128
gradients, 136—137
letter shape changes, 137-139
magnifying glass effect,
179-192
motion effects, 134-135
outlined, 128
patterned, 136
reflections of, 204—207
shadowed, 135
stamp effects, 130-134
warping, 123-124
word-wrapping, 119-120
Text Tool (T), 18, 119-136, 218
texture (See tiled backgrounds)
textured paper backgrounds,
112-113
textured stone backgrounds,
111-112
Texturizer filter, 112
thumbnails, 207-208
customizing actions, 257-258
multiple images, 253—-256
web photo galleries, 261
tiled backgrounds, 93-117
brushed metallic background,
103-104

filling areas, 243—-245
gradient backgrounds, 102
granite backgrounds, 108-109
rice paper, 113-117
striped backgrounds, 99
subtle effects, 106
textured paper, 112-113
textured stone, 109-112
wood-grain backgrounds,
105-108
title bars, 91
Toggle Character Palette button,
120-122
tone adjustments, 144
toolbox, 2, 4, 12, 192-193
tracking, 121
Transform options, 215
transparency
(See also opacity)
adjusting with the Layers
palette, 43
graphics formats and, 6-8
selection tools, 12
transparent backgrounds, 54,
204
transparent GIFs, 99
trimming images (See Crop tool)
troubleshooting, preferences file
and, 26
tutorials, 26, 250
tweening, 268, 270

U

Unsharp Mask filter, 172-173
unwanted elements, removing,
220-221

vV

Vanishing point filter, 210-213
vector buttons, 63
Vector Mask option, rounding

corners, 47
vector masks, 19, 193, 215
magnifying glass effect, 185
resizing a layer, 33
vector shapes, 214
letter shape changes, 138
reusing, 40
Vivid Light blend mode, 154,
156

W

Warp option, 215
Warp Text dialog, 123—-124
watermarking, 258-259
Web content palette, 239
web optimized images
content area shadow, 247
crop-and-save method,
241-243
methods of creating, 236, 243
slice method, 236—-240
web photo galleries, 261-263,
265
whites, improving, 141-144
wood-grain backgrounds,
105-108
Word documents, viewing
images in, 41
word-wrapping, 119
workspaces, 2-5
Wrap Around option, Offset
filter, 94
wrapping text, 119

VA

zooming
Hand Tool and, 20, 199
isolating parts of images, 203
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